
Microsoft Office applications work 
best when you use them together. We’ll 
show you how to access your Outlook 
contact information directly from a link 
in your Excel spreadsheet.

Your familiar Windows Explorer 
receives a face lift in the new Windows 
Vista. Before you tear your hair out trying 
to make sense of the different features 
and the revamped interface, check out 
our article’s four tips for using the Vista 
Explorer to its full potential.

Yo u w a n t  t o  p r e s e n t  s e v e r a l 
different InDesign layout options to 
your clients, but you may end up saving 
each option as its own file. We’ll show 
you how Photoshop’s layer comps can 
come in handy for your InDesign layout 
possibilities.

Putting your training into practice.
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From the Editor

Leverage your contact information to 
instantly send email from Excel

As an avid Internet user in our increasingly connected world, you’re used to clicking on 
a hyperlink for additional information on the web. But, you can also leverage the power 
of hyperlinks to connect Excel and Outlook. Depending on the syntax you use, these 
hyperlinks can:

•		  Launch a corresponding Contact form in Outlook, as shown in Figure A. 

•		  Create a pre-addressed blank email to the Contact. 

•		  Generate a pre-addressed email with a subject line already in place.

Why connect Excel and 
Outlook?
By linking Excel to Outlook, you avoid entering 
contact information that’s already in Outlook 
contact forms into an Excel spreadsheet. It also 
helps ensure accuracy, since you need only 
make changes to the employee’s information 
in Outlook. You can also quickly launch an 
email directly from the Contact form. Let’s look 
at how you can easily set up some hyperlinks 
in Excel that make your email and contact 
management chores a breeze.

Make the connection
If you’ve already entered contact data into 
Outlook, and you want to be able to quickly 
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access that data from within a worksheet, you 
don’t need to reinvent the wheel. Instead, 
add a hyperlink to each cell in a column of 
names in an Excel workbook to connect them 
with the corresponding Outlook forms.

To create a hyperlink in Excel to a 
Contact form:

1.		  In your Excel worksheet, select the 
cell containing the name you wish 
to link and press [Ctrl]K or choose 
Insert | Hyperlink to display the Insert 
Hyperlink dialog box. (We choose cell 
A6, which contains the name of our 
contact, Walter Skinner.) 

2.		  Click on the Existing File Or Web Page 
icon in the Link To panel. 

3.		  In the Address text box (Type The File 
Or Web Page Name text box in Excel 
2000), type Outlook:Contacts/~Walter 
Skinner, where Walter Skinner is the 
name of the contact you’re linking. 
(There’s no space between the tilde (~) 
and the name of the contact.) 

4.		  Click OK to link your Excel cell to the 
corresponding Outlook contact form. 

Now, when you click on the cell that’s a 
hyperlink (cell A6, in our example), the 
associated Outlook contact form displays. 
Just repeat the process for each contact and 
you’ll have a worksheet with connections to 
your contact forms.
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Three ways to send 
emails with hyperlinked 
connections
By adjusting the hyperlink’s syntax, 
you can cause it to perform different 
functions in conjunction with Outlook. 

Send an email from a Contact 
form
If you want to send an email from Excel, 
you can use the hyperlink to access the 
Contact form in Outlook. When the form 
opens, click the New Message To Contact 
button on the form’s Standard toolbar to 
create a pre-addressed email message. 

Send an email straight from 
Excel
If you don’t need to access the contact 
information from within Excel, you 
can bypass Outlook’s contact form 
altogether. To create a hyperlink that 
immediately launches a pre-addressed 
email message in your default email 
application, simply follow these steps:

1.		  Enter the email address directly 
into a cell in your workbook—Excel 
creates the necessary hyperlink for 
you automatically.

2.		  Right-click on the hyperlink and 
select Edit Hyperlink.

3.		  Enter the text you want displayed 
in the spreadsheet in the Text To 
Display text box, and click OK.

Send an email with a preset 
Subject line
You can customize the hyperlink further 
to generate a pre-addressed email with a 
subject line already filled in. For instance, 
we could edit the links in our spreadsheet 
so we only have to click on the link to 
generate a new email with the subject line 
Please update your latest sales figures. 

1.		  Enter the text you want displayed 
in Excel, and then press [Ctrl]K 
with the cell selected to launch the 
Insert Hyperlink dialog box. 

2.		  Click E-mail Address at the bottom 
of the Link To panel, and enter 
the desired email address in the 
E-mail Address text box. (Excel 
automatically adds a mailto: label 
when you enter text in the E-mail 
Address text box.)

3.		  Enter the text you’d like to appear 
in the subject line of the email 
you’ll send from the hyperlink (e.g. 
Please update your latest sales 
figures) and click OK.

Increase your Excel-to-
Outlook connection speed
The procedures we’ve discussed work 
regardless of whether Outlook is running—
though if it isn’t open, you may need to log 
in whenever you click on one of your new 
hyperlinks in Excel. Here are a few tips to 
quickly connect Excel and Outlook.

•		  Launch Outlook and leave it 
running in the background before 
you click on a hyperlink. 

•		  Or, rather than launching Outlook, 
just click on a contact link in Excel 
and leave the Contact form open. 
As long as a form is open, you 
won’t have to log in to Outlook 
when you click on a hyperlink in 
Excel.

A 	 You can quickly access an Outlook Contact’s information by using hyperlinks in 
Excel.

Business skills for the new world of work
In business today, productivity is key to your success. Whether that means setting up 
projects for success, forecasting and analyzing trends, or managing critical business 
information, it is vital that you have the skills to work at peak performance. You already 
know how to use Microsoft® Office System applications. New Horizons offers Microsoft 
Business Skills Series Courses to teach you how to use those applications to more effi-
ciently manage, work with, and prioritize information to make better decisions. Go to 
www.NewHorizons.com for information on courses that cover topics such as:
§	4002 Forecasting and Trend Analysis Using Microsoft Office Excel 2003
§ 4003 Summarizing Microsoft Office Excel 2003 Data to Make Better Business Decisions
§	4005 Beyond the Spreadsheet: Managing Financial Information Using Microsoft 

Office Access 2003 

http://www.newhorizons.com


�
August 2008New Horizons Computer Learning Centers, Inc.

Four ways to get the best of the old and  
the new with Vista Explorer 

As an XP power user, you’re surely excited about the Vista enhancements, but also wary of 
changes that will inhibit your productivity. Vista’s new take on Windows Explorer could easily 
slow you down with all the added features, and the familiar menus and buttons you won’t find 
when you first open Explorer. To speed up your travels through Vista’s Explorer, we’ll guide you 
through the new look and show you where you can find your favorite options.

Familiarize yourself with 
the new Explorer
Microsoft significantly changed the way 
Windows Explorer looks and operates 
in Vista—especially with the default 
appearance. As you can see in Figure A, 
the differences include:

•		  No title bar

•		  No menu bar

•		  An address bar that indicates 
folders and subfolders with right 
pointing triangles rather than 
backslashes

•		  A Search text box

•		  A Favorite Links pane

•		  A minimized Folders pane

•		  An Organize button on the new 
Command bar you’ll use to change 
Explorer’s layout and also cut, copy, 
paste and create new folders

•		  A Details pane along the bottom 
that lists important information 
about the folder you’ve opened. 

Since we opened Computer in Figure A, 
the Details pane indicates information 
such as the computer name and amount 
of memory.

In addition to the new look, Vista’s 
Windows Explorer comes with some 
new names and new “Explorers.” In 
Table A, we compare the XP names to 
those used in Vista. Figure B shows how 
some folders, such as Music, have their 
own Explorer look and functionality. 

Navigate through 
Explorer with ease
Now that you’re familiar with the 
new look, let’s take a look at a few 
modifications every XP power user 
should consider. With these changes, 
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you can quickly find the features you’re 
accustomed to, and gain a few that you’ll 
wish you could add to XP.

1. Personalize the Favorite 
Links pane
With the Favorite Links pane, you have 
swift access to your Documents, Pictures, 
Music, and more. You can see the default 
links available in the Favorite Links pane in 
Figure B. To maximize your productivity, 
personalize this pane for your needs. 

To add and remove Favorites from 
the Favorite Links pane:

1.		  Right-click in the blank space 
in the Favorite Links pane and 
choose Open Favorite Links 
Folder, as shown in Figure C.

2.		  A new Explorer window opens 
to C:\Users\UserName\Links 

I n f o r m a t i o n  S y s t e m s  P r o t e c t i o n

Table A:
Windows XP versus Windows Vista Explorer names

Windows XP Windows Vista

My Computer Computer

My Documents Documents

My Network Places Network

Windows Explorer
Windows Explorer (or just 
Explorer)

http://www.newhorizons.com/content/CatalogSearch.aspx?Core_PK=200003138&ML=true
http://www.newhorizons.com/content/CatalogSearch.aspx?Core_PK=200003139&ML=true
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http://www.newhorizons.com/content/CatalogSearch.aspx?Core_PK=200003143&ML=true
http://www.newhorizons.com/content/CatalogSearch.aspx?Core_PK=200003140&ML=true
http://www.newhorizons.com/content/landingThankyou.aspx?id=1314
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(where UserName is your Windows 
username.)

3.		  To delete a link, simply right-click 
on its shortcut and choose Remove 
Link from the pop-up menu.

4.		  To add a link, right-click in the 
blank space on the right pane and 
choose New | Shortcut.

5.		  Enter the path to the shortcut you 
wish to add and click Next.

6.		  Enter a name for the shortcut and 
click Finish.

Another way: You can also copy existing 
shortcuts and paste them as links into 
your Favorite Links.

Figure D shows that we added to our 
Favorite Links a link (shortcut) to an 

existing network share 
(i.e., \\SUPERPC\Temp). It 
appears in the right pane 
(because we’ve opened 
the Links folder) and also 
in the Favorite Links pane.

2. Welcome back the 
Menu bar
Many XP power users take a look at the 
new Explorer and their first thought 
is “Where is the File menu?” If you’re a 
Menu bar fan and haven’t quite mastered 
the new Command bar, you’re probably 
wondering if you can get the Menu bar 
back—especially once you discover that 
some Menu bar options don’t come with 
the Command bar. Fortunately, you can 
add the Menu bar to Vista’s Explorer.

To add the Menu bar to Explorer:

1.		  Click on the Organize menu option 
on the Command bar.

2.		  Select Layout | Menu Bar to add a 
check to the item. 

As shown in Figure E, a checked Menu 
Bar brings back the File and other menus 
(although they’re modified for Vista).

3. View every drive on 
your computer
By default, Vista’s Explorer displays the 
Favorite Links pane with the Folders 

Scattering breadcrumbs
Because the Vista Address bar’s 
dropdown list shows you a list of 
previously accessed locations, XP pros 
often refer to it as the breadcrumb 
bar—a bar that shows you’ve where 
you’ve been like Hansel and Gretel’s 
breadcrumb trail.

By default, Windows Vista’s Explorer window offers enhancements that put 
the information you need front and center.A 	

B 	
Music Explorer offers 
detailed information 
such as Artists and 
Albums, but also offers 
quick buttons to play 
files or burn them to disk 
without opening another 
program.
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pane minimized. In Windows XP, you 
can toggle the Folders button on the 
Standard Buttons toolbar to open the 
Folders pane for quick access to My 
Network Places, the Recycle Bin, USB 
devices, and more. If you’re hunting for 
that Folders button on the Command 
bar, stop. To access your Folder pane, 
click on Folders under the Favorites Links 
pane as shown in Figure E.

4. Leap to your 
destination
As previously mentioned, Vista offers 
an updated Address bar that replaces 
the familiar backslashes with triangles. 
For XP buffs, you can still access folders 
by typing in a path in UNC format (e.g., 
\\SUPERPC\Temp, C:\Windows), and you 
can also still click on the Address bar’s 

dropdown list to view other locations 
you’ve recently accessed.

But Microsoft added the new tri-
angles for a feature-rich reason, rather 
than just for looks. Those triangles 
open dropdown lists that allow you to 
use the Address bar to jump from your 
current location to any other location 
on your computer. To take advantage 
of this feature,

1.		  Click on any triangle in the Address 
bar to convert it to a dropdown list. 
A list of locations available at that 
level appears, as shown in Figure F.

2.		  Click on the location to which you 
want to jump. Explorer switches to 
that location in a flash.

C 	
Add to your Favorite Links or ditch 
links you don’t use—just start by 
opening the Favorite Links folder.

Add any shortcut to your Links folder and it will appear in the Favorite Links 
pane no matter what folder you open.D 	

E 	 Navigate in Windows XP-
like fashion by opening the 
Folders pane.

F 	
Jump from folder 
to folder with the 
new Address bar 

dropdown lists.
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Add variety to your layouts using Photoshop 
layer comps in InDesign

Where were Photoshop layers and layer comps the last time you needed to present multiple compositions of a page 
layout to a client? The layers and (since Photoshop CS) layer comps probably existed in your image files, but the ability 
to access them from within InDesign didn’t. Therefore, your only recourse was to save and place each version as a 
separate file—a time-consuming method at best. Thankfully, all that has changed! Using the image shown in Figure 
A, we’ll demonstrate how InDesign CS2 and CS3 allow you to control the visibility of layers and layer comps when 
they exist in Photoshop files.

Follow the rules
Controlling layer visibility in InDesign is 
a fairly simple concept. As with all new 
technology, though, there are certain 
guidelines. Please heed the following to 
ensure your files print correctly:

•		  Don’t flatten the original 
Photoshop files. The layers in the 
linked source file must exist in 
order for InDesign to print them.

•		  Don’t edit the files in such a way as 
to remove the required layer data. 
This includes changing the layer 
names, number of layers, stacking 
order, and layer comp definitions.

Now that we’ve got the preliminaries out 
of the way, let’s have some fun.

Selectively import layers
The first place you can control layer 
visibility is when you place your 

Photoshop files in InDesign CS2. The 
Layers tab is the newest addition to the 
Image Import Options dialog box, but it’s 
easy to overlook, since InDesign doesn’t 
open it by default. 

To control layer visibility as you 
place an image:

1.		  Create a new InDesign document.

2.		  Choose File > Place. The default 
shortcut is [command]D ([Ctrl]D in 
Windows).

3.		  Select the image file in the Place 
dialog box, and then either select 
the Show Import Options check 
box and click Open, or [shift]-click 
Open.

4.		  Click the Layers tab in the Image 
Import Options dialog box. As 
shown in Figure B, the file is set to 
show only the Background layer—

Related Courses
•		  InDesign CS3 – Level 1

•		  InDesign CS3 – Level 2

indicated by the absence of the 
Eye icon next to the other layers 
in the Show Layers list. The layers 
import whether or not we make 
them visible, so let’s leave them as 
is for now. 

5.		  Click on the Layer Comp pop-up 
menu to see the list of available 
layer comps built into the file. You 
can select a specific layer comp if 
you wish, but all layer comps will 
import into InDesign, regardless 

D e s i g n ,  M e d i a  &  G r a p h i c s 

A 	
Combine InDesign’s 

strengths with 
Photoshop’s strengths 

for stellar results.
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of which one you select. Let’s 
leave this set to Last Document 
State for now. 

6.		  Choose Keep Layer Visibility 
Overrides from the When Updating 
Link pop-up menu. This will 
maintain the layer overrides 
we’ll apply in InDesign after 
we place the file (rather than 
use Photoshop’s layer visibility 
settings) in the event that we 
update the link to the original file.

7.		  Click OK, and then click the loaded 
graphics icon on the page to place 
the image.

Edit layer visibility
After you place a Photoshop file, you 
can edit layer visibility overrides to show 
variations that exist within the source file.

To edit layer visibility:

1.		  Select the image and choose 
Object > Object Layer Options.

2.		  Select the Preview check box.

3.		  Click in the small box to the left of 
each layer to show or hide the layer 
in your document, as shown in 
Figure C. Or, choose an alternate 
state from the Layer Comp pop-up 
menu, as shown in Figure D.

If you don’t see an eye icon beside a layer, that layer is hidden.B 	

C 	
When you show different layers, 
your image gets a makeover.
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Note: In CS2 we noticed a delay while 
InDesign generated the preview when 
selecting individual layers for Custom 
layer comps. If your preview is slow, try 
clicking the Preview checkbox again after 
you make your selections.

4.		  Click OK when you’ve made your 
selection.

Tip: Use the Links palette and the 
Preflight command to easily identify 
Photoshop files with layer overrides.

Using these guidelines, you can take 
advantage of Photoshop layers and layer 
comps, and ensure images display as you 
need and output as you expect.

Graphic & Design eTips to Enhance 
Your Work
If you are an expert at what you do, then you 
want to sign up for FREE New Horizons Graphics & 
Digital Designer eTips. Each week you will receive 
expert advice from our experienced editors that 
will improve your productivity and enhance your 
work. Learn more about the applications you use 
everyday, including: Adobe Illustrator, Adobe 
InDesign, Adobe Pagemaker, Adobe Photoshop, 
Digital Photography and QuarkXPress. Imagine 
the possibilities with the skills you’ll gain!  

You can choose a different Layer Comp from the pop-up menu.D 	
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